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Lesson Details
Learning Objectives: 

To provide users with a basic understanding of how to use 
the Analysis Cube to answer business questions.

Duration: 75 minutes

Pre-requisites: None

Recommended:
None
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Analysis Cube
You do not need any knowledge of the underlying database 
tables and the relationships between them to extract data 
from the Analysis Cube using Excel.

Instead, you reference data using the Reference Data Set (RDS):

• Organization

• Fund

• Account

• Values (Appropriations, Allotments)

• Etc.

Fund
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Gaining Insight by Answering Questions
This allows you to pose questions in business terms, 
such as:
• What modifications have impacted this Account?

• What changes were made to my modifications between 
these two points-in-time?

• Which Organizations contributed to the change in Staff 
costs over the Budget Year? 
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Pivot Tables
• Query large amounts of data in many user-friendly ways

• Subtotal and aggregate numeric data, summarizing data by categories and subcategories

• Expand and collapse levels of data to focus your results, and drill down to details from the summary 
data for areas of interest to you

• Move rows to columns or columns to rows ("pivoting") to see different summaries of the source data

• Filter, sort, group to focus on just the information you want.

BIDS Ad hoc Reporting Excel Pivot Tables

Pivot tables are one of the most powerful and useful features in reporting and 
analysis. Users can think of a pivot table as a report. However, unlike a static report, a 
pivot table provides an interactive view of your data. The goal of any analysis is to 
draw insight from the raw data. But when your data contains hundreds of tables with 
thousands of rows it’s impossible to make sense from it just by looking at it with the 
naked eye and scrolling up and down. Drawing insight very often means that you will 
have to take out certain pieces of the data and wrangle the way they present their 
content, for example, through summary statistics. Summary statistics are used by 
data analysts to summarize a set of observations to communicate a large amount of 
information as simply as possible. With very little effort (and no formulas) you can 
look at the same data from many different perspectives, grouping data into 
categories, breaking down data into years and months, filtering data to include or 
exclude categories, and even building charts

The Budget module provides two different approaches to pivot tables:
• BIDS Ad hoc Reporting 
• Excel Pivot tables
• Microsoft Excel
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BIDS Ad hoc Reporting
• Pivot table component for web reporting

• Accessed through the BIDS web portal

BIDS Ad hoc Reporting is a pivot table component for web reporting, accessed 
through the BIDS web portal, that provides the user with a simple interface to 
aggregate, filter, sort, and group data to focus on specific subsets. The user 
can drill up and down and pivot to see the data from different points of view.
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Excel Pivot Tables
Data is extracted into an Excel PivotTable.  You can 
then: 
• Combine the data from the budget module with other 

data

• Employ the full functionality of Excel to consume and 
present the data.

Microsoft Excel provides users with functionality to create pivot tables against the 
cube inside an Excel workbook.

You can combine data from the budget module with data from other sources to 
provide more comprehensive reports.
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BIDS Ad hoc Reporting
• Pivot table component for web reporting

• Accessed through the BIDS web portal

BIDS Ad hoc Reporting is a pivot table component for web reporting, accessed 
through the BIDS web portal, that provides the user with a simple interface to 
aggregate, filter, sort, and group data to focus on specific subsets. The user 
can drill up and down and pivot to see the data from different points of view.

Click the cube icon on the toolbar to access this feature.
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Connect
Connect to a data source:

• Select OLAP (XMLA) to connect to the cube and enter the details

• Select Local Report to connect to a report downloaded and saved on your PC

Click the Connect icon to connect to the source of the data that you want to include 
in your report. There are two options; 
• OLAP (XMLA) which is a connection to an analytics cube. Enter these details to 

make the connection:
• For this training session:

• Proxy URL: /Budget-TRN/api/cube-basic.ashx (then click CONNECT)
• Data source info: vm-as400-test
• Catalog: Budget-TRN
• Cube: Model (then click OK)

• For Production:
• Proxy URL: /Budget/api/cube.ashx (then click CONNECT)
• Data source info: TBA
• Catalog: Budget
• Cube: Model (then click OK)

• Local Report which allows you to connect to a report that has been downloaded by 
you, or someone else, and saved on your PC.
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Hands-on Lab Exercise 1
1. Connect the cube

Objective
1. Create a connection to the cube

Duration: 5 minutes

Process
Connect to the cube
1. Click the cube icon in the toolbar to access the BIDS Ad hoc Reporting page
2. Click the Connect icon and enter the following details

a. Proxy URL: /Budget-TRN/api/cube.ashx (then click CONNECT)
b. Data source info: vm-as400-test
c. Catalog: Budget-TRN
d. Cube: Model (then click OK)
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Fields
Drag fields into the:

• Rows
• Columns
• Filters
• Values

The Field icon opens the dialog where you define the how you want to set up the 
rows, columns, and filters for your report and the data values to display. You can also 
click the diagonal arrow in the upper-right corner of the grid or the charts. On the left 
of the Field dialog, you will see a box with all fields from the cube. 
• When there are more than 50 fields in the cube, a search box is displayed
• When multilevel hierarchies are configured (such as Organization), or fields are 

grouped in folders, an Expand All option is displayed

To create a report, you drag items from the Fields list into the Rows, Columns, Filters, 
and Values boxes. You can drag as many fields into each box as you need for your 
report. You can also include any level of a hierarchy such as Organization, allowing 
you to include JobNumber, Division, or Department.

Click the APPLY button once you’ve finished your layout to view the report.
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Fields

The layout we set up in the precious slide will produce a report like this. By default, 
the application will the display the value and sum the values in each row and column, 
but you can also choose one of the alternate aggregation options by clicking the 
sigma icon (Σ) in the Values box of the Fields dialog..
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Tiles

Once you’ve created and saved a report, it is listed on the Tiles page and you can 
open the report by clicking the title of the tile and also save it as a favorite.
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Hands-on Lab Exercise 2
1. Create a report

Objective
1. Create a basic report from the cube data

Duration: 10 minutes

Process
Create a basic report
1. Click the Fields icon
2. Drag these items from the Fields list:

a. Report filters: Year
b. Columns: Fund Name
c. Rows: Organization Display Name
d. Values: Appropriation $ (then click APPLY)

3. Keep this report open
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Export
Print the report or export it to several different formats.

Use the Export tab to print the current content or export it to HTML, CSV, Excel, 
Image, or PDF format. 
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Download
Download the report to a file on your PC.

Click the Download icon to save the report to a file on your PC. Once the file has 
saved, you can distribute it to other users who can then open it using Local Report 
option under the Connect icon.
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Grid
The Grid tab switches the view to the grid.

The Grid tab switches the view to the grid.
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Charts
Download the report to a file on your PC.

The submenu of the Charts tab shows all available pivot charts. 

Once you have selected a chart type, choose an active measure from the drop-down 
lists in the upper-left corner. By default, only one measure can be active at a time. To 
allow choosing more than one active measure, select the Multiple values checkbox in 
the Charts tab’s submenu.
Open the filter view by clicking a field’s name above the chart.

Access the context menu by right-clicking a graphical element.
Double-click a graphical element to drill through it and see non-aggregated data.
If there are several fields in rows, expand or collapse inner field values by clicking a 
member name on the X-axis. To expand fields in columns, use member names on the 
legend.
In the same way, you can drill up & down multilevel hierarchies in rows and columns.
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Hands-on Lab Exercise 3
1. Create a chart

Objective
1. Create a basic chart from the report

Duration: 10 minutes

Process
1. Click the Chart icon select Column, then make the following selections from 

the dropdowns:
a. Organization Display Name: clear the Select all checkbox, then search 

for 0200 and select several JobNumbers beginning with 0200
b. Fund Name: clear the Select all checkbox, then select General Fund 

and Federal Grant Fund. You may also choose other funds if you wish. 
2. Click the Fullscreen icon
3. Hover the cursor over one of the columns in the chart; a tooltip displays
4. Click the Fullscreen icon again, then the Grid icon. The report now reflects the 

selections made for the chart. You can save this layout by clicking the reports 
dropdown and selecting Save As.
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Format
• Number formatting

• Conditional formatting

The Format tab provides two options: number formatting and conditional formatting.

Format cells allows you to modify any of the following properties: text alignment, 
thousand separator, decimal separator, decimal places, currency symbol, currency 
align, null value, and format as a percentage.

Conditional formatting provides basic formatting of values based on several 
conditions such as less than, greater than, equal, among other options. In the pop-up 
window, click the plus icon to add a new condition. You can apply the condition 
either to all values or to a specific measure from the drop-down list. Select the 
condition type and value, font family, and size. Click the A-letter icon to change the 
default font and background colors. Choose new colors from the color picker or enter 
their hex codes. Click APPLY to add these colors to the condition. You can see a 
preview of the result inside the box on the right. To see the result on the grid, 
click APPLY. You can remove the condition by clicking the recycle bin icon on the right 
of the condition.
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Options
Manage treatment of Grand totals and Subtotals

Click the Options icon to see a pop-up window with layout options such as grand 
totals and subtotals. 
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Fullscreen
Switch to the fullscreen mode. Exit this mode by pressing Esc.

Click Fullscreen and switch to the fullscreen mode. Exit this mode by pressing Esc.
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Report Components

When you design an analysis report, you're creating a workbook that consists of:
• A Connection that specifies where to get the data 
• A PivotTable that specifies what data to get 
• Optionally, a report layout that specifies how to display the data using Excel’s range of formatting 

and data presentation tools.

This module does not provide instruction on using Excel 
formatting and data presentation tools.  Please refer to 
Microsoft or other third-party training courses.

Microsoft Excel provides users with functionality to transform data into actionable 
intelligence that informs the organization’s strategic and tactical business decisions. 
Pivot Tables enable users to access and analyze budget data and present analytical 
findings in reports, summaries, dashboards, graphs, charts, and maps to provide 
users with detailed intelligence about the state of the budget

You can combine data from the budget module with data from other sources to 
provide more comprehensive reports.
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Connection: Connecting to the Cube
In Excel 365:

1. Open the Data tab
2. Click Get Data
3. Click From Database
4. Click From Analysis Services

The Data Connection Wizard opens …

Other versions of Excel may look different but 
follow a similar procedure.

You need to create a Connection before you can extract data from the Analysis Cube.  
A Connection specifies how to connect to the cube.

In Office 365: 
1. Open the Data tab
2. Click Get Data
3. Click From Databases
4. Click From Analysis Services.

This opens the Data Connection Wizard.
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Connection: Server
Connect to Database Server:

1. http://10.1.32.4/OLAP/msmdpump.dll
2. Enter the user name and password provided

Click Next

RE0

For the purposes of this training course, use the following information:

1. Server name: http://10.1.32.4/OLAP/msmdpump.dll
2. Select Use the following User Name and Password and enter the details provided.

Click Next to move to the next page.
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RE0 What do we enter?
Ray Elliott, 2023-07-20T05:50:16.501



Connection: Cube
Select Database and Tables:

1. Select the database
Use the lookup to select the required database
• For training: Select Budget-TRN

No tables!!
2. Connect to a specific cube
• For training: Select Model

3. Click Next

There are several databases on the server; Budget and DW (Datawarehouse); select 
one from the list.

You do not need any knowledge of the underlying database tables and the 
relationships between them to extract data from the Analysis Cube using Excel. 
Instead, you reference data using the Reference Data Set (RDS); such as Organization, 
Fund, Object, etc.; select the cube from the list.
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Connection: Save and Finish
Save the connection details:

1. Save to a file on your PC or network
2. Enter a description
3. Enter a friendly name
4. Click Finish

You now save the connection details to a file on your PC or network. The default 
location is under your ‘Documents’ folder … This PC\Documents\My Data Sources.

1. You can accept the default file name and location (This PC\Documents\My Data 
Sources) or edit the name and browse to a new location.

2. Optionally you can enter a  Description which can be helpful for other users to 
understand your Connection definition.  This is especially useful if you have 
entered a Friendly Name.

3. Optionally, you can enter a more user-friendly name for the Connection.  This 
name will be displayed when you use this connection later.

4. Click Finish to save the connection and start the report building process.
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Report: Import Data
1. View the data as a Pivot Table Report

2. Select which worksheet and cell you want 
the report to start

3. Click OK

On the Import Data dialog you specify how you want to view the data, as a Pivot 
Table Report or Chart, or an Excel table. You also specify where you want Excel to 
start the data.
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Report: Pivot Table
An empty pivot table 
report is created.

A. Canvas: The location 
where the data will be 
displayed

B. Pivot Table Pane: the 
panel used to 
drag/drop fields into 
the report
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Hands-on Lab Exercise 4
1. Connect to the cube

Objective
1. Create a connection to the cube

Duration: 5 minutes

Process
Connect to the cube
1. Open Excel
2. In the Data tab, click Get Data > From Database > From Analysis Services
3. Connect to Database Server

a. Server name: https://bids.uat.gfmis-nonprod-
guam.com/OLAP/msmdpump.dll

b. Use the following User Name and Password: Select this option and 
enter the details you have been provided (then click Next)

4. Select Database and Table
1. Database: Budget-TRN
2. Cube: Model (then click Next)

5. Save Data Connection File and Finish: Click Finish
6. Import Data: Leave the defaults, click OK
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Report: Pivot Table Pane
The pivot table pane has three main sections:

A. Search box

B. Field List: Each item represents an element of the RDS 
(such as Organization, Account, Adjustment Type, etc., or a 
value such as Appropriation $)

C. Layout area
i. Filters
ii. Columns
iii. Rows
iv. Values

The Pivot Table Pane is where you define the how you want to set up the rows, 
columns, and filters for your report and the data values to display. It has three main 
sections:
A. Search box:
B. Field List: Each item represents an element of the RDS, such as Organization, 

Account, Adjustment Type, etc., or a value such as Appropriation $. Values are 
indicated with a sigma (Σ) icon.

C. Layout Area
i. Filters: Used for filter operation in a pivot table.
ii. Columns: Displays as columns in a pivot table with Column Labels as the 

values for selected fields
iii. Rows: Displays as rows in a pivot table with Row Labels as the values for 

selected fields.
iv. Values: Displays the financial or statistical data for the selected fields.

To create a report, you drag items from the Field list into the Rows, Columns, Filters, 
and Values boxes in the Layout area. You can drag as many fields into each box as you 
need for your report. You can also include any level of a hierarchy such as 
Organization, allowing you too include, JobNumber, Division, or Department.
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Click the APPLY button once you’ve finished your layout to view the report.
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Report: Pivot Table Pane
Drag fields into the:

• Rows
• Columns
• Filters
• Values

The layout we set up in the precious slide will produce a report like this. By default, 
the application will the display the value and sum the values in each row and column, 
but you can also choose one of the alternate aggregation options by clicking the 
sigma icon (Σ) in the Values box of the Fields dialog..
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Report: Pivot Table Pane

The layout we set up in the precious slide will produce a report like this. By default, 
the application will the display the value and sum the values in each row and column.

If you selected a hierarchical filed such as Organization you will be able to drill drown 
from the summary level to the detail JobNumbers.
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Hands-on Lab Exercise 5
1. Create a basic report

Objective
1. Create a basic report

Duration: 5 minutes

Process
Create a basic report
In the PivotTable Fields pane:
1. Drag these items from the Fields list:

a. Report filters: Year
b. Columns: Fund Name
c. Rows: Organization
d. Values: Appropriation $ 

2. In cell B1, select 2024 from the dropdown

The report is showing the total Appropriation for Department 02, by Fund. We can 
drilldown into Divisions, and even, JobNumbers, by clicking the + icon net to the Row 
label in column A.
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Pivot Table Do’s and Don’ts
DO

 Always select Values and Filters first. Then Rows and Columns This will help ad hoc run faster as it is not 
looking for as much data. 

 In general, there should be no more than around 20 columns of data for an Ad Hoc to function properly.

 Delve in! Get creative! Ad hoc is a very powerful analytical, tracking, and review tool for budgeting.
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Pivot Table Do’s and Don’ts
DON’T

 Do not place a field in columns that has a lot of individual values. For example, if Comptroller Subobject
Code is dragged to the column then hundreds of columns will be generated, and the ad hoc will slow down 
or fail to load. 

 Do not try to use two different drill downs ("Agency Drill Down" and "Object Drill Down“) in the same ad 
hoc. Drill downs use a lot of Excel processing power, and with two in the same table the result will likely be 
a failure to load or Excel freezing.

 Make sure that the Values you have selected has all the characteristics of your other selections. For 
instance, if Fund Dollars is the Value and Subprogram is on the Row, that will create issues since Revenue 
information is not designated at the Subprogram level.

*General Rule – if an Ad Hoc pivot table is taking more than 30 seconds to update, it is likely because the 
options chosen don’t go well together. Press “Esc” on your keyboard to cancel.
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Pivot Table Components
PivotTable Analyze tab: Contains commands that will enable you to explore the data in the PivotTable

PivotTable
PivotTable Name
Options

Group Selection
Grouping 
Ungrouping
Group Field

Active Field
Active Field
Field settings
Expanding Field 
Collapsing Field

Data
Refresh

Active Field

PivotTable Group Data

Please refer to Microsoft documentation, or the many on-
line pivot table tutorials, for additional information .

PivotTable Analyze tab contains commands that will enable you to explore the data in 
the PivotTable. 

Once you have created your report and saved the workbook, you can click the 
Refresh icon to update the data from the database.
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Pivot Table Components
Design tab: Contains commands used to structure the PivotTable with various report options and style options.

Layout
Subtotals
Grand Totals
Report Layout
Blank Rows

PivotTable Style Options
Row Headers
Column Headers
Banded Rows
Banded Columns

PivotTable Styles

PivotTable Style Options

Layout PivotTable Styles

Please refer to Microsoft documentation, or the many on-
line pivot table tutorials, for additional information .

The Design tab contains commands used to structure the PivotTable with various 
report options and style options.
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Thank you for undertaking the lesson:
Advanced Data Analysis

Please complete the survey:

3.003 Advanced Data Analysis 44


